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Abstract
A spectrophotometric hemoglobin assay is widely used to estimate the extent of brain hemorrhage
by measuring the amount of hemoglobin in the brain. However, this method requires using the
entire brain sample, leaving none for histology or other assays. Other widely used measures of
gross brain hemorrhage are generally semi-quantitative and can miss subtle differences. Semi-
quantitative brain hemorrhage scales may also be subject to bias. Here, we present a method to
digitally quantify brain hemorrhage using Photoshop and Image J, and compared this method to
the spectrophotometric hemoglobin assay. Male Sprague-Dawley rats received varying amounts of
autologous blood injected into the cerebral hemispheres in order to generate different sized
hematomas. 24 hours later, the brains were harvested, sectioned, photographed then prepared for
the hemoglobin assay. From the brain section photographs, pixels containing hemorrhage were
identified by Photoshop® and the optical intensity was measured by Image J. Identification of
hemorrhage size using optical intensities strongly correlated to the hemoglobin assay (R=0.94).
We conclude that our method can accurately quantify the extent of hemorrhage. An advantage of
this technique is that brain tissue can be used for additional studies.
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Introduction
Current ways to estimate the amount cerebral hemorrhage include assigning
semiquantitative scores (Yenari et al., 1997b; Yenari et al., 1998), counting numbers of
brain slice faces containing hemorrhage (Lyden et al., 1990; Thomas et al., 1993),
hemoglobin assay (Choudhri et al., 1997), computed tomography (Bardera et al., 2009; Liu
et al., 2008), and magnetic resonance imaging (Neumann-Haefelin et al., 2001; Yenari et al.,
1997a). All of these methods have disadvantages. For example, semiquantitative scores and

Correspondence to: Midori A Yenari, M.D. Dept of Neurology, UCSF Neurology (127) VAMC 4150 Clement St. San Francisco, CA
94121 Tel: 415 750-2011, FAX: 415 750-2273 yenari@alum.mit.edu.
aBoth authors contributed equally to the work.
Publisher's Disclaimer: This is a PDF file of an unedited manuscript that has been accepted for publication. As a service to our
customers we are providing this early version of the manuscript. The manuscript will undergo copyediting, typesetting, and review of
the resulting proof before it is published in its final citable form. Please note that during the production process errors may be
discovered which could affect the content, and all legal disclaimers that apply to the journal pertain.

NIH Public Access
Author Manuscript
J Neurosci Methods. Author manuscript; available in PMC 2011 July 15.

Published in final edited form as:
J Neurosci Methods. 2010 July 15; 190(2): 240–243. doi:10.1016/j.jneumeth.2010.05.004.

N
IH

-PA Author M
anuscript

N
IH

-PA Author M
anuscript

N
IH

-PA Author M
anuscript



brain slice counting are relatively crude measures, and may not accurately estimate subtle
differences. CT and MRI scans require specialized equipment, and their accuracy compared
to standard histology may vary depending on the sequence used or timing (Neumann-
Haefelin et al., 2001). The hemoglobin assay is the most accurate way to quantify the
hemorrhage, but this method requires the homogenization of brain tissue, making it
unavailable for other purposes. This can be a disadvantage especially when there is a need to
study the relationship between hemorrhage and parallel mechanisms. In order to circumvent
this problem, we developed a method of digitally measuring the hemorrhage from fresh
brain sections that comparably estimates the extent of hemorrhage as the spectrophotometric
hemoglobin assay.

1. Materials and Methods
1.1. Animal model and tissue preparation

Male Sprague-Dawley rats (Simonson, Gilroy, CA, USA), 300–500 grams, were housed and
treated in a humane manner in strict accordance with institutional guidelines and approval.
The cerebral hemorrhage model was generated as described elsewhere with modifications
(Hua et al., 2002; Okauchi et al., 2009). In brief, rats were anesthetized with 5% isofluorane
delivered into an anesthesia induction chamber with oxygen and air supplied at a ratio of 0.2
L/min oxygen: 0.8 L/min air. Once surgical planes of anesthesia were attained (assessed by
absence of hind leg withdrawal to pinch), isoflurane was decreased to 2.5% throughout the
remainder of the surgery through Stereotaxic Anesthesia Mask (cat #: 921434, VetEquip,
Inc. Pleasanton, CA, USA) mounted on the stereotactic frame (Stoelting, Wood Dale, IL,
USA). The left femoral artery was catheterized to obtain autologous blood. Rats were placed
in a stereotactic frame and one or two cranial burr holes (1 mm) were drilled by a dental drill
(#18000-17, Fine Science Tools Inc. Foster City, CA, USA) on the right coronal suture 3.5
mm lateral to the midline, 1 mm anterior or/and 1 mm posterior to midline. The burr holes
were filled with bone wax, and a 25.5 gauge needle was inserted stereotactically into the
right hemisphere. Autologous whole blood in volumes of 50 μl (n=8), 100 μl (n=7), 150 μl
(n=5), 200 μl (n=6) or 250 μl (n=3) were injected at a rate of 2.5 μl /min using a Harvard 11
Plus Syringe Pumps (Harvard Apparatus Inc, Massachusetts, United States). For animals
receiving 50 μl, coordinates were: 2 mm anterior & 3.5 mm lateral to bregma, depth 5.5 mm.
For the other groups, two sites were injected with coordinates at 1) 2 mm anterior & 3.5 mm
lateral to bregma, depth 5.5 mm; 2) 2 mm posterior & 3.5 mm lateral to bregma, depth 5.5
mm. 20 minutes post injection, the needle was removed. 100 μl of 0.5% bupivocaine was
injected at the surgical wound site, and the wound site was then closed. The animals were
allowed access to food and water ad libitum. 24 hours after surgery they were euthanized
with an overdose of isofluorane, decapitated, and the brains were rapidly removed and
sectioned coronally at 2-mm intervals. The sections were transferred to a petri dish, and
images of the gross sections were immediately collected by scanning on a digital scanner
(HP scanjet 4370, Product Number: L1970A, Hewlett-Packard Company, Palo Alto, CA,
USA) including a ruler in the scanning field as a reference. The resolution of each image
was 600 dpi and the scanned images were saved as TIF files for the next processing step.

1.2. Isolation of the hemorrhagic portion of the images
After brain section images were collected, areas of hemorrhage were isolated from the
images using Photoshop 6.0 (Adobe, San Jose, CA). Digital images (Fig 1A) taken from
scanned brain sections were opened into Photoshop. The image of the ipsilateral brain
section (Fig 1B) was selected and copied to the clipboard. A new image was created, and the
contents of the clipboard pasted twice into the new image to create two identical layers,
layer 1 and layer 2. This was done in order to place the brain image onto a transparent layer
in a new image. Next, the background (currently empty) layer was deleted, leaving only the
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pasted layers of the brain image. Using the Magic Wand tool, the image space surrounding
the brain section was selected and deleted in layers 1 and 2, thus isolating only the brain
tissue to be analyzed (it is helpful to photograph the brain tissue on a white background to
easily isolate the brain from the background in Photoshop). Next, all hemorrhage was
converted to black. This was accomplished by selecting layer 2, selecting the menu item
Adjustments->Replace color, and using the dropper selector to select a color from the center
of the hemorrhage. One sample may not be enough to select the entire hemorrhage if the
areas of hemorrhage are not confluent, so it may be necessary to add selections using the
dropper with the plus next to it. Once the area(s) of hemorrhage was selected, the lightness
is reduced to −100 to blacken the brain area and the fuzziness set to 65 to allow for more
gradations in the color values being converted to black. Once the color replacement was
applied, the blending options in the layers dialog is changed to “difference”, thus revealing
only the portions of the brain section containing blood. In order to make measurement of the
hemorrhage easier, a new layer was created, filled with black, and moved to the bottom of
the layer stack, making all of the image black, except for the selected hemorrhage area. The
resulting image was then saved as a TIFF file with no layers (Fig 1C). (For detailed
instructions, see the supplementary materials)

1.3. Measurement of the hemorrhage area
To quantify the hemorrhage area, the processed image was loaded into ImageJ v. 1.31
(available as freeware from http://rsbweb.nih.gov/ij/) and converted into a 16-bit image
through the menu option Image->Type->16-bit. Then, the image was thresholded using the
menu option Image->Adjust->Threshold. The type was set to Black & White and the top
slider moved to a value of 34 (the researcher can set this to a value useful to their dataset,
but the same value should be used in all images being analyzed from an experiment). The
resulting thresholded image is binary and will only show the hemorrhage region (Fig 1D).
To measure the area and number of pixels, the menu option Analyze->Measure was
selected, the values recorded and the process repeated on subsequent images (supplementary
materials and figures). The total hemorrhage volume was calculated by summing the
hemorrhagic area in each section and multiplying by the thickness of each section. The `Set
Scale' function in Image J was used to convert pixel numbers to standard units
(http://rsbweb.nih.gov/ij/docs/menus/analyze.html#scale). To determine inter rater
reliability, two independent observers measured 4 representative brains using the above
method.

1.4. Spectrophotometric Hemoglobin Assay
This hemoglobin assay is similar to that previously published by Choudri et al (Choudhri et
al., 1997). After brain sections were scanned, the sections from the ipsilateral cerebral
hemisphere were collected from each animal. Distilled water (1ml) was added to each
hemisphere, and the tissue was homogenized for 30 strokes in a Dounce homogenizer and
centrifuged at 13000 rpm for 30 minutes. The hemoglobin containing supernatant was
collected, and 80 μl of Drabkin's solution (Sigma) was added to a 20 μL aliquot. After
incubating at room temperature for fifteen minutes the optical density of the solution at 550
nm wavelength was measured to assess hemoglobin content. Measurement of each sample
was repeated four times. In order to verify that the measured absorbance by this method
reflected the amount of hemoglobin, human erythrocyte hemoglobin (Sigma) of known
concentrations ranging from 0.156 mg/ml to 20 mg/ml) were analyzed simultaneously along
with each brain tissue hemoglobin assay in order to generate a standard curve. Thus, the
hemoglobin concentration of each brain was calculated from the standard curve. To convert
these values to volume, the hemoglobin concentration was multiplied by the lysate volume
(on the average, 1.3 ml) then divided by a previously published hemoglobin concentration in
rat blood (12 g/dl (Williamson and Ets, 1926)).
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1.5. Pearson Correlation Study and Linear Regression
A Pearson correlation and linear regression analysis was applied to compare results from the
two methods studied using SigmaStat v. 3.11 (Systat Software, Inc. Chicago, IL, USA).
Student's T-test was applied to compare differences between 2 groups, and sample size
calculations were performed based on these data. Kappa statistics to estimate inter rater
reliability was computed using MedCalc v. 11.2.1.0 (MedCalc Software, Mariakerke,
Belgium). All data are expressed as Mean±SE.

3. Results and Discussion
Increasing volumes of injected autologous blood not surprisingly led to larger hemotoma
sizes. A strong proportional relationship was observed between brain hemorrhage volume
determined from brain hemoglobin concentration measured using the spectrophotometric
hemoglobin assay and the digitally calculated hemorrhage volume (Fig. 2A). Linear
regression analysis showed that both measurements correlated highly in a linear fashion
(R=0.94). The relationship between the two methods could be described by: blood
volumespectrophotometric = 2.844 + (0.665 × blood volumedigital). Hemorrhage volumes
determined from either method were near the known injected volume (Fig 2B). These values
were somewhat lower than the injected volume of blood due to loss from seepage of injected
blood into the subdural and/or subarachnoid space, and remaining blood in the needle. The
values derived from the spectrophotometric method were also somewhat lower than that
using the digital method. The reason for this is not entirely clear, but could stem from our
not measuring blood hemoglobin from each rat. Nevertheless, the general relationship was
similar for both methods. Further, we had two independent observers (XT & AB) measure
hemorrhages from the same brain sections and found very good inter rater reliability with a
kappa score of 0.83.

Since blood volumes of 50–100 μl are typically studied in rodent brain hemorrhage models,
it was important to establish that these methods could reliably distinguish between these
amounts of blood. As shown in figure 2C, both methods could distinguish between these
amounts of blood present in the brain. Further, the variability of the measurements was
similar for both methods with standard deviations of 30% and 45% for the digital and
spectrophotometric methods, respectively.

We show that this method is highly correlated to the hemoglobin assay. An obvious
advantage is that the brain sections can be saved for other assays, circumventing the need to
study additional animals. This method can potentially minimize any error introduced by
cerebral edema or variations in ischemic lesion size inherent to many brain ischemia models.
The same brain sections can be used to evaluate edema or infarct size for comparison to the
amount of hemorrhage observed, rather than having to study a separate cohort of animals.
This method could also be adapted to other similar measurements where colorimetric data
are revealed in gradations of the same color family, such as estimates of blood brain barrier
permeability by measuring Evans blue dye extravasation or IgG accumulation (Tang et al.,
2008; Tang et al., 2007). Appropriate validation would need to be performed for each new
measurement applied, including the assessment of brain hemorrhage at time points other
than those studied here. Hemoglobin degradation can lead to color changes that may not be
accurately captured by this method. Regardless, this method can also be easily implemented
with equipment that is not particularly specialized or expensive.

Supplementary Material
Refer to Web version on PubMed Central for supplementary material.
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Figure 1. Image Processing by Photoshop and Image J
A digital image of cerebral hemorrhage scanned on a Hewlett Packard scanner (A). The
ipsilateral brain section with cerebral hemorrhage selected for measurement is shown (B).
The brain section after processing by Photoshop showing pixels indicate only regions of
cerebral hemorrhage (C). The digital image was further processed by Image J with the
hemorrhage now appearing white, and is ready for digital quantification (D).
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Figure 2. The digitally calculated hemorrhage volume is highly correlated to hemorrhage volume
determined by hemoglobin spectrometry
A: A Pearson correlation showed that the brain blood volume estimated from a
spectrophotometric hemoglobin assay was highly correlated to the calculated hemorrhage
volume using a digital, Photoshop/ImageJ based method (R= 0.94, P <0.001). A linear
regression analysis indicated that the relationship is linear. B: Comparisons of known
volumes of injected blood to digitally measured or hemoglobin spectrometry derived
volumes. Black circle: digitally measured hemorrhage volume; white circle: blood volume
based on spectrophotometric hemoglobin assay; C: Estimating brain hemorrhage volume by
either method could distinguish between animals receiving 50 μl blood and 100 μl (T-test,
*P<0.01)
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